
 
 
 
Dear customer 
 
ROHM Co., Ltd. ("ROHM"), on the 1st day of April, 2024,  
has absorbed into merger with 100%-owned subsidiary of LAPIS Technology Co., Ltd. 
 
Therefore, all references to "LAPIS Technology Co., Ltd.", "LAPIS Technology" 
and/or "LAPIS" in this document shall be replaced with "ROHM Co., Ltd." 
Furthermore, there are no changes to the documents relating to our products other than 
the company name, the company trademark, logo, etc. 
 
Thank you for your understanding. 
 

ROHM Co., Ltd. 
April 1, 2024 



 
 

 
Starter Kit for Speech Playback MCU 
ML610Q306 Starter Kit Start Guide 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1  ML610Q306 Starter Kit hardware configuration 
 
 
 
■ Use in a stand-alone 

ML610Q306 SE/Scale Playback Sample Program (hereinafter SE/Scale Playback Sample Program) has already been written in the 

flash memory of the ML610Q306 Speech Application Board at the time of shipment. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 System configuration in the stand-alone 
 

 You can also turn on the ML610Q306 Speech Application Board by connecting the AC-USB power adapter (sold 
separately) to the USB cable. 

 
1. Connection of the hardware and starting the ML610Q306 SE/Scale Playback Sample Program 
1-1. Set the SW4 on the ML610Q306 Speech Application Board to “ON” side. (At the time of shipment, SW4 is set to “ON” side.) 
1-2. Connect the USB cable (micro B) and the speaker to the ML610Q306 Speech Application Board. (Figure 2) 
1-3. Connect the USB cable to the PC. 

When connecting the USB cable to the PC, the power is supplied to the ML610Q306 Speech Application Board and start the 
SE/Scale Playback Sample Program. 

1-4. Install the USB-serial conversion driver. 
The ML610Q306 Speech Application Board uses FTDI’s FT230XQ as the USB serial conversion IC. 
To operate the SE/Scale Playback Sample Program in the Scale Playback mode, download and install the driver from the FTDI 
website in advance. 
 For driver installation, follow the Installation Guide posted on the FTDI website. 

 

2. Operation of the SE/Scale Playback Sample Program 
When the SE/Scale Playback Sample Program starts, it displays “LAPIS Technology” to the LCD on the Application Board as 
figure 3 and becomes the operation mode select mode.  
 
 
 

Figure 3 LCD display immediately after starting the SE/Scale Playback Sample Program 
 
2-1. Operation mode select mode 

In the operation mode select mode, the SW1(4-direction switch) is used to select the operation mode. 
Select the SE playback mode or scale playback mode on the left and right of the SW1 and push the SW3 to switch to the selected 
mode. 
 
 
 
 

Figure 4 LCD display of the operation mode selection mode 
 

2-2. SE playback mode 
In the SE playback mode, the SW1(4-direction switch) is used to select the sound effect (SE). 
Move the cursor up and down to the setting item and select the setting value on the left and right. 
For PHR, select phrase number (0 to 15) corresponding to the sound effect, and for RPT, select playback once (Once) or playback 
repeat (Loop). 
When pushing the SW2, the sound effect of the displayed phrase number is played. When pushing the SW2 again during playback, 
playback is stopped. 
When pushing the SW3 in this status, the mode moves to the operation mode select mode. 
 
 
 
 

Figure 5 LCD display of the SE playback mode 
 

2-3. Scale playback mode 
In the Scale playback mode, the scale is played according to the data received by the UART (serial port). 
When pushing the SW3 in this status, the mode moves to the operation mode select mode. 
 
 
 

Figure 6 LCD display of the scale playback mode 
 
 
 

In this mode, terminal software such as Tera Term is used. 
Set the UART (serial port) communication settings of the terminal software as follows. 
 

Table 1 UART(serial port) communication settings 
Item Setting Item Setting 

Baud rate 115200bps Stop bit 1 bit 
Data length 8 bits Logic Positive logic 
Parity bit None Bit order LSB first 

 
If you enter a key from a PC while the terminal software is running, data will be sent from the PC and the scale will be played 
according to the data received on the application board. 
The scale for UART received data is as follows. If data not listed below is received, nothing is processed in this mode. 
 

Table 2 The scales corresponding to the UART received data 
UART 

received data 
Scale UART 

received data 
Scale UART 

received data 
Scale 

‘z’ C (Low tone) ‘a’ C (Middle tone) ‘q’ C (High tone) 
‘x’ D (Low tone) ‘s’ D (Middle tone) ‘w’ D (High tone) 
‘c’ E (Low tone) ‘d’ E (Middle tone) ‘e’ E (High tone) 
‘v’ F (Low tone) ‘f’ F (Middle tone) ‘r’ F (High tone) 
‘b’ G (Low tone) ‘g’ G (Middle tone) ‘t’ G (High tone) 
‘n’ A (Low tone) ‘h’ A (Middle tone) ‘y’ A (High tone) 
‘m’ B (Low tone) ‘j’ B (Middle tone) ‘u’ B (High tone) 

    ‘1’ C (High tone) 
 
For details of the operation of this program, refer to the “ML610Q306 SE/Scale Playback Sample Software AP note” which include 
in this starter kit. 

 

3. Shut down 
3-1. Disconnect the USB cable from the PC. 

 

■ Use with the Development Support Tools 
This section describes the process of building the Speech/Scale Playback Sample Program, loading to the ML610Q306 Application 

board and running. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ML610Q306 Speech Application Board 
Figure 7 System configuration using development support system 

 
4. Copy of the ML610Q306 Starter Kit Software Package to your PC 
4-1. Insert the “ML610Q306 Starter Kit Software Package” DVD into the DVD drive of your PC. 
4-2. Copy all files in the “ML610Q306_StarterKit” folder to the C drive root (C:\) of your PC. 

 
• Copy the “ML610Q306_StarterKit” folder to the folder which contains using half-width characters except space if you 

do not copy them to the C drive root (C:\) of your PC. 

 
4-3. Eject the DVD from the DVD drive of your PC. 

 
5. Development support system: Installation of U8/U16 Development Tools 

This section describes the process of installing of U8/U16 Development Tools software, the Multiple Flash Writer, the Device 
Information Files and the EASE1000 V2 USB drivers.  

 
• Please use Release 2.3.0 or later as the version of U8/U16 Development Tools. 
• Operating environment：Windows 7*, Windows 8/8.1*, Windows 10*   * 32-bit (x86) and 64-bit (x64) version. 
• Please log on with an administrator account. 
• When U8/U16 Development Tools or software tools for speech MCU existing in your PC, uninstall these programs at the 

beginning.  
For uninstallation, refer to step #19. 

 
5-1. Extract the archive of the U8DevTool_Rx_xx_x.zip in the “ML610Q306_StarterKit” folder that you copied in Step #4. 

*” Rx_xx_x” depends on the release version of the U8/U16 Development Tools. 
5-2. Double-click the U8DevInstaller.exe in the “Setup” folder located in the folder which extracted the U8DevTool_Rx_xx_x.zip. 

When this file is executed, the InstallShield Wizard will install the U8/U16 Development Tools software, the Multiple Flash Writer, 
the Device Information File and the EASE1000 V2 USB driver. 

 
• Follow the instructions of the InstallShield wizard to install.  
• Agree to “SOFTWARE LICENSE AGREEMENT for SOFTWARE DEVELOPMENT TOOLS”. 
• Do not change option settings. 
• Select “Typical” in the Setup Type selection part. 
 

When the InstallShield Wizard displays the “InstallShield Wizard Completed” message box finally, close it. 
After that, installation has finished. 

 
6. Development support system: Installation of Speech LSI Tools 
6-1. Extract the archive of the Speech_LSI_Tools_Rxxx.zip in the “ML610Q306_StarterKit” folder that you copied in Step #4. 

*” Rx_x_x” depends on the release version of the Speech LSI Tools. 
6-2. Double-click the Setup_Speech_LSI_Tools_e.exe in the “Setup” folder located in the folder which extracted the 

Speech_LSI_Tools_Rx_x_x.zip. 
 
• Follow the instructions of the installer.  
• Agree to “LICENSE AGREEMENT”. 
• Do not change option settings. 
 

7. Development support system: Installation of Speech Table Generation Tool 
7-1. Extract the archive of the SpeechTableGenerationTool_vxxx.zip in the “ML610Q306_StarterKit” folder that you copied in Step #4. 

*” vxxx” depends on the release version of the Speech Table Generation Tool. 
The SpeechTableGen.exe in the folder which extracted the SpeechTableGenerationTool_vxxx.zip is an executable file. 
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8. Connection 
8-1. As shown in figure 7, connect the ML610Q306 Speech Application Board to the EASE1000 V2 On-Chip Emulator (hereinafter 

“EASE1000 V2”). 
8-2. Connect the EASE1000 V2 to the PC using the USB cable. 
8-3. Connect the speaker to the ML610Q306 Speech Application Board. 
8-4. Connect the ML610Q306 Speech Application Board to the PC using the USB cable. 

 
9. Installation of the ML610Q306 Starter Kit Sample Software 

Extract the archive of the StarterKit_SampleSoftware_vxxx.zip in the “ML610Q306_StarterKit” folder that you copied in Step #4. 
By this step, the ML610Q306 Starter Kit Sample Software that includes ML610Q306 SE/Scale playback Sample Software is 
extracted to the “ML610Q306_StarterKit¥StarterKit_SampleSoftware_vxxx” folder. 

*“vxxx” depends on the version of the ML610Q306 Starter Kit Sample Software. 

 

10. Launching the LEXIDE-U16 

This section will take you through the process of launching the LEXIDE-U16 Integrated Development Environment (hereinafter 

“LEXIDE-U16”). 
• For details of the LEXIDE-U16, refer to the “LEXIDE-U16 User’s Manual”. 

Start Menu > U8 Tools > U8 Software Tools Document >LEXIDE-U16 User’s Manual 
 

10-1. Launch the LEXIDE-U16 from the Start Menu. 
Start Menu > U8 Tools > LEXIDE-U16 

The LEXIDE-U16 will display [Select a directory as workspace] dialog box after displaying a Splash Screen. 
10-2. In the [Workspace] field of the [Select a directory as workspace] dialog box, select the 

“ML610Q306_StarterKit¥StarterKit_SampleSoftware_vxxx¥Software” folder which was extracted the 
StarterKit_SampleSoftware_vxxx.zip in step #9. 
And click the [Launch]. 

*“vxxx” depends on the version of the ML610Q306 Starter Kit Sample Software Package. 
 
 
 
 
 
 
 
 
 

Figure 8 Select a “Workspace” folder in the [Workspace] field of the [Select a directory as workspace] dialog box 

 
• When you specify a folder other than the above as the folder specified in the [Workspace] field, specify a folder that 

complies with the “Restrictions on Input Value” described in the “LEXIDE-U16 User’s Manual”. 
 
A little while, the LEXIDE-U16 will launch. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9 The LEXIDE-U16 immediately after startup 

 
11. Importing the SE/Scale Playback Sample Program project 

This section will take you through the process of importing the SE/Scale Playback Program project to the LEXIDE-U16. 
11-1. Select the [File] menu > [Import...] menu command of the LEXIDE-U16. 

The [Import] dialog box will be opened. 
11-2. Select [General] > [Existing Projects into Workspace] in the [Import] dialog box and click [Next]. 

 
 
 
 
 
 
 
 
 
 
 

Figure 10 Select [General] > [Existing Projects into Workspace] in the [Import] dialog box 

 
11-3. Select “ML610Q306_StarterKit¥StarterKit_SampleSoftware_vxxx¥Software¥2001_SpeechScale” folder in the [Select root 

directory] field of the [Import] dialog box. 
The selected folder contains the SE/Scale Playback Sample Program project file(“.cproject”, “.project”).  

*“vxxx” depends on the version of the Speech/Scale Playback Sample Program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11 Select “root directory” in the [Project path] of the [Import] dialog box 

 
The SE/Scale Playback Sample Program project will be displayed in the [Import] dialog box (Fig 12). 
 

11-4. Confirm that “2001_SpeechScale” displayed in the [Project] filed of the [Import] dialog box is checked and click the [Finish] 
button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12 Select “2001_SpeechScale” project in the [Import] dialog box. 
 
The “2001_SpeechScale” folder will be displayed in the [Project Explorer] of the LEXIDE-U16. 
 
 
 
 
 
 
 
 
 

Figure 13 The LEXIDE-U16 after loading the SE/Scale Playback Sample Program project. 
 

12. Build of the SE/Scale Playback Sample Program 
This section will take you through the process of building the SE/Scale Playback Sample Program. 

12-1. Confirm that the “2001_SpeechScale _default” is displayed in the “Launch Configuration” field of the LEXIDE-U16. 
 
 
 

 
 

Figure 14 The “Launch Configuration” field of the LEXIDE-U16. 
 
12-2. Click the [Build] button on the toolbar of the LEXIDE-U16 to build (compile, assemble, and link) the SE/Scale Playback Sample 

Program. 
 
 
 
 
 
 
You will be able to see the message “Build Finished.” 
 

13. Start debugging  
Load the SE/Scale Sample Program into the ML610Q306, executes this sample program to the beginning of the main function, and 
start debugging. 

 
13-1. Select the “Debug” in the [Launch Mode] field of the tool bar of the LEXIDE-U16. 
 
 
 
 

Figure 15  Select “Debug” in the [Launch Mode] field of the LEXIDE-U16. 
 
13-2. Click the [Launch in ‘Debug’ mode] button of the toolbar of the LEXIDE-U16. 

 
 
 
 
 
The LEXIDE-U16 will load the SE/Scale Sample Program into ML610Q306, reset ML610Q306, execute this sample program, and 
break at the beginning of the main function. 
 
[Supplementary explanation] 
During the above processing, the LEXIDE-U16 will display the processing status at the bottom right. 

 

 
 
 

Figure 16 Displaying the processing status of the LEXIDE-U16 

 



 
 

 
After that, LEXIDE-U16 will display the dialog (“Confirm Perspective Switch” dialog) confirming the perspective switching shown 
in figure 17.  

 

13-3. Click the [Yes] button of [Confirm Perspective Switch] dialog. 
The DTU8 debugger will start and load the Speech/Scale Playback Sample Program. 
 
 
 
 
 
 
 
 

Figure 17 The [Confirm Perspective Switch] dialog 
 
LEXIDE-U16 will switch to the debugging perspective (hereinafter “the [Debug] perspective”). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 18 LEXIDE-U16 immediately after loading the SE/Scale Playback Sample Program and executing up to the main function. 
 

14. Run of the SE/Scale Playback Sample Program 
14-1. Click the [Resume(F8)] button of the LEXIDE-U16 

 
 
 
The SE/Scale Playback Sample Program will be executed from the beginning of the main function and this program operates in the 
same way as standalone. 
 

15. Stop the SE/Scale Playback Sample Program 
15-1. Click the [Suspend] button of the LEXIDE-U16. 

 
 
 
The SE/Scale Playback Sample Program will stop. 
 

16. Terminating Debug 
16-1. Click the [Stop] button of the LEXIDE-U16. 

 
 
 
 
<terminated> will be displayed in the [Debug] tab of the LEXIDE-U16. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19 LEXIDE-U16 immediately after terminating Debug. 
 
[Supplementary explanation] 
To return to the layout before debugging, click the [C/C++] perspective button on the right side of the toolbar. 
 
 
 
 
 
 
 

17. Shut down 
<LEXIDE-U16> 

17-1. Select the [File] menu > [Exit] command of the LEXIDE-U16. 
The LEXIDE-U16 will shut down. 
 

<Hardware> 
17-2. Disconnect the USB cable which is connected to the ML610Q306 Speech Application Board from your PC. 
17-3. Disconnect the USB cable which is connected to the EASE1000 V2 from your PC. 

 
 
 
 

 
18. Change of Sound Code Data and Control Program 

When changing a sound code data and a control program, use the Speech LSI Utility, Speech Table Generation Tool and 
LEXIDE-U16. 
The following figure shows the input/output relation of these tools. 
 

• This starter kit does not contain the WAV data. Please prepare the WAV data by customer.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20  Input/output relation of the Speech LSI Utility，Speech Table Generation Tool and LEXIDE-U16 

 
In this section, it shows the example which changes sound code data by using three WAV data files. 

* Please prepare the WAV data files by customer. 
In this example, it assumes that the WAV data files are in the “WAV_DATA” folder on the desktop. 
For the reference, as for WAV data, sample sound effects are posted on the support site of Lapis Technology, so you can 
download and use them. 

 
<Generation of sound code data (*.s) by Speech LSI Utility> 

18-1. Launch the Speech LSI Utility from the Start Menu. 
Start Menu > LAPIS TECHNOLOGY > SpeechLSIUtility3 

 
 

18-2. Select “ML610Q306” by the [Device]. Then select the WAV data files in the “WAV_DATA” folder by the explorer and drag and 
drop the selected files to the Speech LSI Utility. 

 
 
 
 
 
 
 
 
 
 
 
 

18-3. Check all the check boxes on the left side and click the [Create…] button. 
 
 
 
 
 
 
 
 
 
 
 

18-4. Since the [Create ROM] dialog will be display, specify the file name by clicking […] button and save the file by clicking the [OK] 
button. In this example, save as “New_speech_data.s” in the “WAV_DATA” folder 

 
 
 
 
 
 
 
 
 
 

 

• For the details of the Speech LSI Utility, refer to the “Speech LSI Utility User’s Manual”. 
Select “Start > LAPIS TECHNOLOGY > Speech LSI Tools Documents” and double click the 
“FJUL_SPEECH_LSI_UTILITY-yy.pdf” in the displayed folder. 
*”yy” depends on the revision of the manual of the Speech LSI Utility. 
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Select ”ML610Q306” by the [Device] 
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<Generation of speech table (speechTbl.asm) by Speech Table Generation Tool> 

18-5. Launch the Speech Table Generation Tool (SpeechTableGen). 
The Speech Table Generation Tool can be invoked by double clicking the “SpeechTableGen.exe” icon in the folder which extracted 
the SpeechTableGenerationTool_vxxx.zip in the above step #7. 

 
 
 

18-6. Set the “Target LSI” to ML610Q306. 
 
 
 
 
 
 
 

18-7. Select the New_speech_data.s which generated in the step #18-4 and drag and drop to the [Speech data file] of the SpeechTableGen. 
Then click [Generate speech table] button. 
The “speechTbl.asm” will be generated in the same folder as the input file “New_speech_data.s”. 

 
 
 
 
 
 
 

 

• For the details of the Speech Table Generation Tool, refer to the “Speech Table Generation Tool User’s Manual”. 
Double click the “FJXT_SPEECH-TABLE-GEN-yy.pdf” in the folder which extracted the 
SpeechTableGenerationTool_vxxx.zip in the above step #7. 
*”vxxx” depends on the version of the Speech LSI Utility. 
*”yy” depends on the revision of the manual of the Speech LSI Utility. 

 
< Overwrite copy speech table (speechTbl.asm) to LEXIDE-U16 project and build project by LEXIDE-U16 > 

18-8. Overwrite copy the speech table (speechTbl.asm) to the folder of SE/Scale Playback Sample Program which is used in the step #11. 
 
 
 
 
 
 
 

• Original speech table can re-generate by specifying the speech_sample_1.s to the SpeechTableGen. The 
speech_sample_1.s is in the same folder. 

 
18-9. Re-build the SE/Scale Playback Sample Program which is used in the step #11 by using the LEXIDE-U16. 

For launch of the LEXIDE-U16 and build of the SE/Scale Playback Sample Program, refer to the step #11, 12. 
 
• When a build error is issued because the size of the speech table or the speech control program is big, reduce the size of 

the sound code data or the speech control program, then re-generate the speech table and re-build the project. 
 

18-10. Run the SE/Scale Playback Sample Program. 
For connection of the hardware, refer to the step #8. For running of the SE/Scale Sample Program, refer to the step #13, 14. 
By selecting one of ‘0’, ‘1’ or ‘2’ of the PHR (phrase number) by the SW1 (4 direction switch) and pushing the SW2, you can 
confirm that the sound has been changed. 
 
• In this example, no sound will sound even if the other PHR is selected because only three sound code data were written.  

To return to the original sound, specify the speech_sample_1.s to the SpeechTableGen and re-generate the 
speechTbl.asm and re-build. 

 
 

19. Uninstallation 
In order to uninstall, you should select the following programs from “Add or Remove Programs” of Control Panel. 
 

• Uninstalling U8/U16 Development Tools Release 2.3.0 or later 

- U8/U16 Development Environment Setup  : LAPIS TecnologyU8/U16 Development Environment Setup 

 

You will be able to uninstall all the below U8/U16 Development Tools. 

- U8/U16 Development Tools software (build tools) : LAPIS TecnologyU8U8/U16 Development Tools 

- U8/U16 Development Tools software (GUI tools) : LAPIS TecnologyU8U8/U16 Development Tools 

- Multiple Flash Writer   : LAPIS TecnologyU8MWU16 Multiple Flash Writer 

- U8/U16 Device Information Files  : LAPIS TecnologyU8U8/U16 Device Information Files 

- USB drivers    : U8/U16 Development Tools Driver 
 

• Uninstalling U8/U16 Development Tools Release 2.00.0 to 2.2.x 

- U8/U16 Development Environment Setup : LAPIS Semiconductor U8/U16 Development Environment Setup 

 

You will be able to uninstall all the below U8/U16 Development Tools. 

- U8/U16 Development Tools software (build tools) : LAPIS Semiconductor U8/U16 Development Tools 

- U8/U16 Development Tools software (GUI tools) : LAPIS Semiconductor U8/U16 Development Tools 

- Multiple Flash Writer   : LAPIS Semiconductor MWU16 Multiple Flash Writer 

- U8/U16 Device Information Files  : LAPIS Semiconductor U8/U16 Device Information Files 

- USB drivers    : U8/U16 Development Tools Driver 

 

• Uninstalling U8/U16 Development Tools Release 1.xx.x or earlier.  

- U8/U16 Development Tools software  : LAPIS Semiconductor U8/U16 Development Tools 

- U8/U16 Device Information Files  : LAPIS Semiconductor U8/U16 Device Information Files 

- USB drivers    : LAPIS Semiconductor U8/U16 Development Tools Driver *1 

*1: There is not USB driver in the U8/U16 Development Tools Release 1.15.4 than earlier. 

 

• Uninstalling Speech LSI Tools 

- Speech LSI Tools   : Speech LSI Tools 

 
 
 
 
 
 

20. The Software Development Support System 
When you need the latest version of the U8/U16 Development Tools software and Speech LSI Tools, you can download the latest 
version from “LAPIS Technology support site” (hereinafter “Support Site”) is a special website that gives registered users. 
Registration is required to access the site using an ID and Password. 
Navigate to the support page by clicking on a link on LAPIS Technology’s home page or by entering the URL in the browser's 
address bar. Then click on the 'Register' link. 

LAPIS Technology support site URL 
https://www.lapis-semi.com/cgi-bin/MyLAPIS/regi/login.cgi 

 
* In order to download the software such as the software development support system, you need to register the 

serial number of the EASE1000 V2 at the time of registration.  
At the time of registration, select “Microcontroller / speech Synthesis LSI”, "EASE1000 V2 " and type "The 
serial number of EASE1000 V2" as follows. 

Category: Microcontroller / speech Synthesis LSI 
Development/evaluation tool name: EASE1000 V2 
The serial number of development tool: The serial number of EASE1000 V2 
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